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First Time Installation

Windows” 95
1. Start Windows' 953,
2. Insert the Love for Saif! disk into vour CD-ROM drive. Enjoy!
[f you've disabled AuroPlay, press the [Start] button, select [Run].
3. Type “DASETUP” and press [ENTER].
(If your CD-ROM drive is not named “D,” substitute its lerrer instead.)

Windows® 3.x
1. Start Windows".
2. Insert the Love for Saifl disk into your CD-ROM drive.
3. Go to Program Manager. From its [File] menu, select [Run].
4, Type “DASETUP” and press [ENTER].
(If vour CD-ROM drive is not named “D,” substitute its letcer instead.)

DOS

Insert the Love for Saif! disk into your CD-ROM drive.

At the DOS prompr, type "D:" and press [ENTER].

(If vour CD-ROM drive is not named "D”, substitute its letter instead.)
3. Then type "CDY and press [ENTER].

4. Then type “INSTALL" and press [ENTER].
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The Start Up Screen

The first time you play Love for Sail! you'll skip the Start Up screen and get right
“into the action.” So dont go looking for it. Dont worry. You'll get to see plenty of
it soon enough!

Resume Your Previous Game
Click this to be placed right back in the game right where you were the last time
you quit. Pretty handy, no? Of course, if you haven't Quir, you cant Resume. (Duh!)

Open an Existing Game
Click this to resume a different saved game. Of course, if you haven't Saved, you
can't Open.

Start A Brand New Game
Click this to start a new game from the very beginning. You'll lose your previous
game, you know. This time, try listening to the Swedish Fire Chief!

Visit the Larry Web Site
Click here and your Web browser might just launch and take you to the Leisure Suit
Larry web site. (If it doesn’t, try wwwi.sierra.com/games/ 1s17 on your own.)

Lemme Qutta Here! (Exit)
Click this and...oh, just take a wild guess!

The Menu Bar

Move your cursor to the upper-left corner of the
game’s graphics area and a menu bar appears. (If your
screen is larger than the game window, be sure to stay
inside the game window and below the title bar)
Select an action from the menu. Most work exactly like other menus you know and
love. Try ‘em all...ac least once. Some will bring you back again and again, scream-

ing with delight!

The File Menu
New starts a new game. (Duh.) You probably won't use this much,
but the File Menu looked all naked withour ir.

Open restores a previously saved game. If you haven't saved your
game, this function is pretry much worthless.

Save saves your current position. But you don't really need this in
Love for Saif! because vou can't die and vou can't get trapped. The newer, easier
method is to just Quit the game. We'll save your place automatically. Then Resume
and vou're right back where you were. But, we kepr Save around just in case you
want to mark some fun spots. Hint: when entering the save game’s descriprion,
Crrl-C quickly Clears away the old description,

Quit is the proper way to leave the game. Your position is saved automarically, so
the next time vou start, you can just select “Resume” on the Scart Up screen and
you'll be returned to right where you were. Note: exiting any other way does not
save your current position, Better hope you saved!
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The Game Menu

Map rakes you to the ship’s map. For more
information, see “Game Controls” below.

Inventory brings up the inventory win-
dow. For more information, see “Game
Controls” below.

Score tells you how you're doing. It's also
on the right mouse-click shortcur menu,

Audio Mixer lets you adjuse the relacive
volume levels of the game’s background
music, dialogue, and sound effects. Don't like our mix? Think you can do better?
Fine! Do your own. (Screw it up? Click “Default.”)

Boss is Coming... Oh, take a wild guess!

Walking Speed lets you change how fast Larry walks,

Tnciease Filth Level makes the game much more rancid.

Deciease Filth Level malees the game much less rancid.

Ship Stabilizer stops the “motion of the ocean” outside the ship’s portholes.

Closed Captioning wurns the sub-titles ar the bottom of the screen off and on.
Highly recommended for airplane flights when you forget your headphones.

The Help Menu
Serious help is available in a variety of locations: hint books, telephone, fax, on-line
services, web sites, etc. See “How to Contact Sierra” on page 20,

Help offers a few suggestions
£ about how to get started
BT i - playing adventure games.

S Hints i
Customer Service

Hints does almost nothing,

About,.. * T Customer Service gives you
i current telephone, fax, and
Email numbers for Sierra
worldwide.

Abour... WARNING: NEVER TRY THIS! Also: do not pause your cursor over the

team members’ faces.




Game Play

The Cursor

The “packaged cursor” means the game is presently busy. Wait a while and the spe-
cial “Larryesque” cursor will appear. Move it around. When it’s »#os highlighted,
clicking it makes Larry walk as close as possible to where you clicked. But when it
does “highlight” (in its own inimitable way), you've found something interactive.
Then you should...

Left Click

When the cursor is highlighted, a left click displays a context-sensi-
tive menu of verbs unique to thar object. Try them all, including
“Other...", which means...

Typing

Selecting “Other...” lets you type in
your own verbs, Typing is important in
Love for Sail! Some puzzles can only be
solved by typing. Bur all you need type
is the verb. Nouns arent necessary.

Type a vetb for “Lefty’s Piano™:

(You clicked on the noun, remember?)

And you usually only need to type one
word. We save the most recent few for you, so vou don’t have to re-type them. And
like Mrs, Bradley tried to tell you in third grade, spelling does count.

Talking

Talking to people produces a varying menu of topics. Again,
“Other...” lets you type in topics of your own.. Here it’s the _ ursr £
verb that's unnecessary. All you need to type is the (usually)
one-word topic. Remember, some puzzles can only be solved

.My account

by typing. Note: Topics change color when vou hear them (for
example, “Telephone” in the illustration). You never need to
listen to a topic a second time, unless you just forgot to take notes the first time!

CyberSNIFF 2000™

Do not become alarmed when you see (and hear!) the CyberSNIFE 2000™ logo,
Do not run screaming from your home. No, it’s just the latest in
multi-multi-media as Love for Sail!tickles yet another of your senses.
When the CyberSNIFF 2000™ logo appears at the bottom of your
screen, carefully remove your CyberSNIFF 2000™ card from its
jewel-encrusted case... (What? Oh.) Sorry. ...from the CD’s jewel box
case. Gently rub your fingernail once across the colored square
matching the number shown. Then, stick your nose in it ...and enjoy!



Right Click Shortcuts

Right clicking anywhere provides a convenient list of shortcuts to com-

Shorteuts

mon menu items. Sure, you eould use the regular pull-down menus,
but this way it’s easy to do the things vou do the most.

The Map

Once vou board the PMS Bouncy, you
receive a map of the ship. It’s the quick
and easy way to move through the
game. No more walking around. From
the pull-down Game menu, select
Map, or use your right-click shortcut
menu. Move the cursor around the
ship until it’s over where you want to
go. Click and “Poof!” You're there.

Inventory
The Inventory Window is where you use the objects you find. From the pull-down
Game menu, select Inventory, or use the right-click shorrcut.
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Tirking Objects: Sometimes when you click
on an object, its menu includes “Take.”
Take it—you'll be glad you did. The object
vou took then appears in your Inventory
window and in the “Use...” list.

Using Objects: To use an object you've taken, first click an on-screen object. Then,
from its resulting menu, select “Use...”. Slide your mouse over and down until it’s
over the object you want to use. Click. Hing first select the on-screen object to
receive the action, then select the Inventory object to be used. Example: to use the
banana on the toilet seat, first click che toilet, Then, from the toilet’s “Use...” menu,
select “Banana.”

Manipulating Objects: Some objects may be manipulated in the Inventory window.
Check each inventory item carefully. Some conceal important information! Try ‘em

alll

Combining Objects: Some Inventory objects may be combined with other Inventory
objects to create new Inventory objects. To do this, go to the Inventory window.
Left click on an object. From its menu, select “Use...”. Slide your mouse over and
down until it’s over the object you want to use. Click. Hins: it works exactly like
the game: first select the on-screen object, then select the Inventory object to use on
it. Example: to rub the banana on the catte prod, first click the cattle prod. Then,
from the cattle prod’s “Use...” menu, select “Banana.”
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Strategy

Love for Saill is a game of exploration. So don't miss anything! Look at each new
scene carefully. Click on anything that causes your cursor to highlight. Try all the
menu choices. Talk to everyone you see. Take notes. Remember whar they say, as it
may come in handy later as something to talk about with one of your new friends.

Things change during the course of the game. New characters may appear. Keep
looking around.

Think creatively. When you get “stuck,” leave and explore other areas. You never

know where you might find just what you need. Above all, relax, let your imagina-
tion run wild, and have fun!
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Be A Star!

Love for Saillis the first computer game in hiscory to put you on-screen and in the action.
Just follow the steps below. OFf course, if any of this doesn't make sense to you, vou're
probably just not ready to “be a star!”

CyberSCAN 2000™

Want to see vour face on-screen? Here’s how: scan a picture of your face and save it
as a 256-color BMP file in your Larry sub-directory. Name it 1.BME See the
BEASTAR.TXT file in that sub-directory for more information. Hine: for best resules,
crop the file so it's mostly vour face.

CyberVOX 2000™

Want to act? Want a role as the off-screen waiter? Use your Windows-supported sound
card and microphone to add your vaice to Love for Sail! Here's how: go to the Larry sub-
directory. Open a file named VOICE. TXT in Notepad. It contains your script and fur-
ther instructions. Also run Sound Recorder (or whatever you use to record wave files).
Position both programs’ windows side-by-side so you can read your lines in Notepad
while recording your dialog. Be funny!

CyberSYSTEM 2000™

Set your Windows wallpaper co LARRY7.BMP in the Larry sub-directory. Then, as you
make progress in the game, we'll update your wallpaper to reflect your “latest conquest.”
Note: Windows only loads vour wallpaper as it stares up, so you may not see it change
until tomorrow.

CyberSOUND 2000™
Add your own sound effects? Sure! Maintaining the tradition of recent Leisure Suit Larry
games, Love for Saill lets you “improve” the game at the rouch of a (Bodily) Function
Key. Try ‘em alll Amuse your friends. Enjoy!
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Credits
Team Larry

Designer, Writer, Director
Al Lowe

Producer
Marlk Seiberr

Assistant Designer & Writer,
Programmer
Don Munsil

Animation Director
Jason Zayas

Lead Programmer
Steve Conrad

Programmer
Mark Martino

Background Design

Jason Piel
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Lead Background Artist
Layne Gifford

Animators
Bill O’ Brien
Al Eufrasio

Art Technicians
Bob Munsil
Bryan Wilkinson

Quality Assurance Lead

Jennifer Gibbs

Sound FX & Additional Music
Ben Houge
Mark Seibert

Additional Credits

Voice Director
Al Lowe

Voice Casting
Al Lowe & Don Munsil

Voice Aunditions
The Voicecaster,

Burbank, California

Voice Recording

Hollywood Recording Services

Voice Recording Engineer
Mike Hanley

DREAMS Software Specialist
David Henry

Background Photographer
Al Lowe

Best Boy
Dale Christensen

Leisure Suit Larry theme
composed by

Al Lowe
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Leisure Suit Larry theme
arranged by
Frank Zottoli

Original music composed by

Frank Zottoli

Ovriginal music performed by

Frank Zotroli, Piane

Kim Hurchcroft, Woodwinds
Tom Warrington, Bass
Claudio Slon, Diwums
Mark Seibert, Guitan
._‘)_')-'mﬁm'zm':', Percussion

Al Lowe, Soprano Saxophone

Steve Conrad, Trombone

Original music vecorded at
Chick Corea’s Mad Hatter studios,
Hollywood, California

Original music engineered
and mixed by
Jeff Hall

Oviginal music mixed at
Maximus Studios,
Fresno, California



Configuration Testing by
Michael D. Jones and the entire Sierra
Oakhurst Quality Assurance Team

Beta Testers
Geoff M. Keighley
Linda Lindley
Wesley Litt
Tim Marley
Dan Milano
Steve Porrer
Della Rogers
Mark Schey
Michael Shavelson
Charles M. Solen

Packaging and Documentation
Heather Lavin
Kerri Willard

Special Thanks To
Terese Gant
Colette Bortinelli
Cindy Vanous
John Williams
Eric Twelker
Bill Moore
Scott Lynch
Jerry Bowerman
Mike Brochu
Ken Williams
Roberra Williams
Walter Forbes
Zippy the Inflatable Wonder Llama
The World Famous Talking Bear
.and all the moms, dads,
husbands, wives, girl friends,
boy friends, & significant others
withour whom this game would have
been done months earlier.

Animation Credits, Animotion

Supervising Animators
David Hicock & Larry Royer

Key Animation
David Hicock
Larry Royer
John Bloom
Bill Davis
Marcus R. Gregory

Fran Krause

Paint Coordinator
Jennifer Robin

Computer Ink & Paint
Jennifer Darsney
Marcus R. Gregory
Frank Krause
W Aric Miller
Jennifer Robin

Peter Wynn
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Animation
Jim Burns
Julie Cornfield
Jennifer Darsney
Aaron P McDowell
Matthew S Filer
Jose Mercado
W Aric Miller
Jon C Parker
Jeft Whitaker
Michael Pringleton
Jennifer Robin
B ] Walker
Guillermo Zubiaga



Animation Credits, LA West

Director of Animation
Ivan Tomicic

Project Coordinator
Susan McGirr

Production Assistant
Danijel Tomicic

Animation Team Leaders
Jurica Saravanja
Ivica Horvac

Amnimators
Jurica Saravanja
Damir Semenov

Zvonimir Cuk
Ivica Horvat
Kristian Dulic
Zeliko Bracic
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Digital Ink & Paint
Computer Artist Lead
Peggy Skrlec

Digital Ink & Paint
Computer Artists
Sasa Zec
Snjezana Lisica
Pegpy Skrlec
Darko Dukaric
Ivana Baric
Scanner
Snjezana Lisica

The Cast
Leisure Sutt Lavty vv: pon i v v sissmssms e i s Jan Rabson
NAVFRIOT: v vosds opi s cries yoiss B asses e e Sl A R Neil Ross
Dewni Moore .. ... Sheryl Bernstein
Drew Bavingmore . .. ..........................Mary Kay Bergman
Mysterious Woman in Black .. ......... ... ... ... ... Tasia Valenza
Victorian Principles ..« .o v vsvinniva st we Jennifer Darling
Jamie Lee Coitus ... ...........................Mary Kay Bergman
Naihms Juee: i s s oo 8 o Selipelais ann s g Jodie Carlisle
Wodoncha Juge v v ovn i s B0 e B s Mary Kay Bergman
PeddV o o pon i bh5 WS e GRS S e s Herselt
Captain Thygh . ............coooovinvineean ..o Sheryl Bernstein
SHAMms: Tak von o v SRR S e R e Julie Amaro
PELOr somic e BRI T S EEE S O9n s Scott Bullock
TOBHEON: i msnsmommemsivmmenit o s fonth sy 5ih Do v Kevin Richardson
e e Scortr Bullock
Jaommies = s s 56 G G 3 B9 DERSERE S TR s ek T
WG acirvnsion st iy e 634 Bas Ss B 255 e was oraeRt Bolocl
WELY o s s ms 0 S5 e SRR SR B A Michael Golff
M BOnHE:, 5t i e ) v veums afh or a0 Neil Ross
Hawats & s D08 Ui S N B SR e Michael Goltt
Diedge Grahan ; v s vis bon a4 b, S eaTs e v A Kevin Richardson
Sl JIEH . v s s e savsisarsisssss s wna o Gws oo SOEEY] BETHSTEL
dre Pauls —oo ot W awn ped denasniias e b Kevin Richardson
RO v i RS N T TR T S R e Neil Ross
Femiale Ship s Aunounier copanis ven v wis 9% w80 pie ue s Tasia Valenza
Ml SHip s ABHUURCEE awn. wme Gommesis st iss s o, b Neil Ross
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How to Gontact Sierra

Technical Support

AUTOMATED TECHNICAL
SUPPORT LINE
(2006) 644-4343

IN THE U.S.

Sierra On-Line

Technical Support

LO. Box 85006

Bellevue, WA 98105-8506
Main: (206) 644-4343
Fax: (206) 644-7697

8:15 am - 4:45 pm PST
Monday-Friday

IN THE U.K.

Sierra On-Line Limired

4 Brewery Court

The Old Brewery

Theale, Reading, Berkeshir
RG7 5A] United Kingdom
Main: (44) 1-734-303-171
Monday through Friday,
9:00AM-5:00PM

Fax: (44) 1-734-303-362

IN FRANCE

Parc Terciaire de Meudon
Immeuble “Le Newton”

25 rue Jeanne Braconnier
92366 Meudon Le Forér Cedex
France

Main: (33) 1-46-01-46-50

7 jours sur 7 de 9h a 21h

Fax: (33) 1-46-30-00-65

IN GERMANY

Sierra Cokrel Deurschland
Robert-Bosch-Str, 32

13-63303 Dreicich

Germany

Main: (+49) 0-6103-99 40 40
Montag bis Freitag von 9-19h
Fax: (+49) 0-6103-99 40 35
Mailbox: (+49) 0-6103-99 40 41

IN SPAIN

Cakrel Educative Mulcimedia
C/ Tomas Redondo, 1-1° F
Edificio Luarca

28033 Madrid

Spain

Main: (34) 1-764-39-69

lunes a viernes de 9h30 a 14h v
de 15h a 18h30

Fax: (34) 1-381-08-39
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IN ITALY

Contact your local distributor or vendor.

MODEM SUPPORT

Internet: hrrpi/fwwwsierra.com
Sierra UK. BBS: (44) 1-734-30-4227
CompuServe: GO SIERRA
America Online: Keyword SIERRA

Direct Sales

U.S. DIRECT SALES
Sierra Direct

7100 W. Center Rd

STE 301

Omaha, NE 68106

Main: (800) 757-7707
Mon-Sar; 7AM wo 11PM CST
Sundays: 8AM to 9PM GST

IN FRANCE

Parc Tertaire de Meudon
Immeuble “Le Newton”

25 rue Jeanne Braconnier
92366 Meudon La Forér Cedex
France

Main: (33) 1-46-01-48-53
lundi au vendredi de 9h a 18h
Fax: (33) 1-46-30-00-65

ON-LINE SALES
CompuServe:
GO SI (CServe Mall)
America Online:
Keyword: SIERRA

Interner: hitp://www.sierra.com

US DISK/DOCUMENTATION
REPLACEMENT & RETURNS
Dick/Documentation Replacement:
Sierra On-Line Fulfillment

PO Box 485

Coarsegold. CA 93614

Producr Retrris:

Sierra On-Line Returns

PO Box 485

Coarsegold, CA 93614

International Support
Services

INTERNATIONAL SALES
Sierra Direct

7100 W, Center Rd

STE 301

Omaha, NE 68106

For direct orders: (206) 746-5771
Fax: (402) 392-9117



UNITED KINGDOM

Sierra On-Line Limited

4 Brewery Court

The Old Brewery,

Theale, Reading, Berkeshir

RG7 5A] United Kingdom

Main: (44) 1-734-30-3171

9:00 am - 5:00 pm M-F

Fax: (44) 1-734-30-3362

Modem: (44} 1-734-30-4227
Disl/CD replacements in the UK. are
£6.00, or £7.00 ourside the UK. Add
“ATTN: Rerurns.”

FRANCE

Parc Tertiaire de Meudon
Immeuble “Le Newton™

25 rue Jeanne Braconnier
02366 Meudon La Forét Cedex
France

Main: (33) 1-46-01-46-50

Fax: (33) 1-46-30-00-65
Disk/CD replacements:

Call for informartion.

GERMANY

Sierra Coktel Deutschland
Robert-Bosch-Ser, 32
D-63303 Dreieich

Germany

Main: (+4%) 0-6103-99 40 40
Montag, bis Freitag von 9-1 Oh

Fax: (+49) 0-6103-99 40 35
Mailbox (+49) 0-6103-99 40 41
Disk/CD replacements:

Call for information.

Hints

U.S. HINT LINE

Sierra Hints

PO Box 53210

Bellevue, WA 98015-3210

Fax: ((206) 562-4223

For Automated Phone Service:
1-900-370-5583

5.75 per minute. {must be 18 years or

older, or have parental permission]. You

may also contact Direct Sales for a hint-

book.

CANADIAN HINT LINE

For automated phone service:
1-900-451-3356

$1.25 per minute {Canadian)

Callers under 18 vears old must have par-

ents permission. You may also contact

Direct Sales ar 800-757-7707 for hint

books.
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ON-LINE HINTS & SUPPORT

Access Sierra’s Hints through

CompuServe by typing: GO SIERRA
then go to Hint Connecrion

Access the Sierra Forum on America
Online with the kcywnrd: SIERRA

FRANCE HINT LINE

36-68-46-50 (hinr line)

2,23F TTC la minute; tarif en vigueur au
1 juiller 1996

(France métropolitaine seulement).

GERMANY HINT LINE
0190-515 616

Kosten: 1,20 DM pro Minute
(Nur in Deutschland verfiigbar)

U.K. HINT LINE

Old Games Hint Line: (0) 1-734-30-4004
{within the UK}

Old Games Hint Line: (44) 1-734-30-4004
{outside the UK)

New Games Hinr Line: (0) 8-91-66-0660
(within the UK only}

NEW SIERRA HINT LINE:

For adventure games released after January
1, 1993. Charged 39p/minute cheap rate,
49p/minute ac other times. Maximum call
length: 7.5 minutes. Maximum charge
cheap rate: £2.93, £3.68 other times.
Must have permission of the person who
pays the phone bill before calling (line
available in the UK only, 24 hours.
Requires a touch tone phone).

SPAIN HINT LINE

Coalkrel Educative Multimedia

C/ Tomas Redondo, 1-1° F

Fdificio Luarca

28033 Madrid

Spain

Tel: (34) 1-764-39-69 (lunes a viernes
de 9h30 a 14h v de 15h a 18h30)

Fax: (34) 1-381-08-39

ITALY HINT LINE

Contact your local vendor,



The Sierra No-Risk Guarantee

The Promise: We want vou to be happy with every Sierra product vou purchase from us. Period.
If for any reason you're unhappy with the product, return it within 30 days for an exchange or a
full refund...even if you bought it retail.

The Only Catch: You've got to tell us why vou don't like the game, Otherwise, we'll never get
better. Send it back to us and we promise we'll make things right. (If you bought it at a retail out-
let, please send yvour original sales receipt.)

Warranty

IMPLIED WARRANTIES LIMITED:

EXCEMT AS STATED ABOVE, SIERRA MAKES MO WARRANT
PRODUCT. SIERRA DISCLAIMS ANY WARRANTY THAT TH
POSE, AND ANY IMPLIED WARRANTY
[PAY DURATION GF THIS LI\{[I LD EXPRE
CALLY DISCLAIMED. SOME ) 5
RANTY LASTS, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOUL

(PRESS OR IMPLIED, REGARDING THIS
WARE 1% FIT FOR A PARTICULAR PUR-

XPRESSLY ANID SPECIFI-

NO CONSEQUENTIAL DAMAGES:
SIERIA SHALL NOT BE LIABLE FOR SPECIAL, INCIDENTAL, CONSEQUENTIAL OR OTHER DAMAGES,
EVEN IF SIERRA [5 ADVISED OF OR AWARE OF THE POSSIBILITY OF SUCH DAMAGES, THIS MEANS THAT
SIERRA '1 ALL NOT BE RESPONSIBELE OR LIABL DR LOST PROFITS O REVENUES, OR FOR DAMAGES
& OF LOSS OF TIME, DATA OR USE OF THE SOFTWARE, OR FROM ANY
L COST OF THE [‘RODL(.'I IN NO EVENT SHALL SIERRAS LIABILL-
L OF : L STATES DO NOT ALLOW THE EXCLUSION
[ON OF INCIDENT. \I Ol C O\‘sl’OLT\II-\I DAMAGES, SO THE ABOVE LIMITATION OR
EXCLUSION MAY NOT ALY TO YOU,

You are entitled to use this product for your own use, but may
not sell or transfer reproductions of the software manual or
book ta other partics in any way, nor rent or lease the prod-
uct to others without prior written permission of Sicrra. You
may use one copy of the product on a single terminal con-
nected to o single computer. You may not network the prod-
uct or otherwise install it on more than one computer or come-
puter terminal at the same time,
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Front Row: Al Eufrasio, Mark Martino, Jennifer Keenan,
Bill O’Brien, Jason Zayas, Mark Seibert, Al Lowe

Back Row, Bryan Wilkinson, Ben Houge, Layne Gifford,
Don Munsil, Jason Piel, Steve Conrad, Bob Munsil
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